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 This Guidance Document is designed only to assist in complying with New Jersey's 
Emission Statement rule (N.J.A.C. 7:27-21).  The Emission Statement Guidance Document has 
not been promulgated by the Department as a rule. Therefore, it does not have a rule's legal 
force and effect.  If any difference is found between the Emission Statement Guidance 
Document and the Emission Statement rule, the rule in all cases and interpretations takes 
precedence over this guidance document. 

Furthermore, the Department is under no legal obligation to notify persons of their 
legal responsibility to comply with the Emission Statement rule (other than the legal 
obligations of the Administrative Procedures Act).  Any mailing of documents done by the 
Department is done strictly as a courtesy. 
 
 



 

3 
 

_______________________________________________________________________________ 
 

_______________________________________________________________________________ 
 
 

by US Postal Service: 
 

Emission Statement Program 
NJDEP – Division of Air Quality 

Mail Code 401-02 
P.O. Box 420 

Trenton, NJ 08625-0420 
 

by Private Carrier: 
 

Emission Statement Program 
NJDEP – Division of Air Quality 

2nd Floor 
401 East State Street 

Trenton, NJ 08608-1501 
 

Telephone: (609) 633-8248 
Fax: (609) 292-1028 

E-mail: emis_statement@dep.nj.gov 
 

Assistance in completing the Emission Statement is available by e-mail or telephone between 
the hours of 9:30 a.m. and 3:00 p.m., Monday to Friday, except on state holidays.  Besides 

existing staff, the New Jersey Department of Environmental Protection may also engage the 
services of a contractor to provide assistance during peak periods of activity.   

 
   

NJDEP:       https://dep.nj.gov/ 
 
Air Energy and Materials Sustainability:  http://www.nj.gov/dep/aqes 
 
Emission Statement Program:    https://dep.nj.gov/boss/emission-statement-program/ 
 
RADIUS:                     https://dep.nj.gov/boss/radius/ 
 
Emission Statement Listserv:    https://dep.nj.gov/boss/emission-statement-listserv/ 
 
NJDEP Online Portal:     https://dep.nj.gov/online/ 
 
N.J.A.C 7:27-21:                     https://dep.nj.gov/wp-content/uploads/aqm/sub21.pdf 
 

 
 

 
The New Jersey Department of Environmental Protection acknowledges all who have participated 
in the development of the Emission Statement Program in New Jersey and the many individuals 
within the United States Environmental Protection Agency's Office of Air Quality Planning and 
Standards. 
 

https://dep.nj.gov/
http://www.nj.gov/dep/aqes
https://dep.nj.gov/boss/emission-statement-program/
https://dep.nj.gov/boss/emission-statement-program/
https://dep.nj.gov/boss/radius/
https://dep.nj.gov/boss/emission-statement-listserv/
https://dep.nj.gov/online/
https://dep.nj.gov/wp-content/uploads/aqm/sub21.pdf
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Most of the state of New Jersey is in non-attainment of the ozone National Ambient Air Quality 
Standards. Since 1990, the Clean Air Act has required states with designated ozone non-attainment 
areas to gather emissions data of volatile organic compounds and oxides of nitrogen. These two air 
contaminants react in the presence of sunlight to form ozone in the lower atmosphere, the 
troposphere, where it affects human health. The Clean Air Act also requires a periodic, 
comprehensive inventory of all air pollutant sources in the state.  
 
The Emission Statement rule, N.J.A.C. 7:27-21, establishes regulations for the annual reporting of 
air contaminant emissions from stationary sources. The air contaminants reported in the Emission 
Statement include carbon monoxide, sulfur dioxide, ammonia, particulate matter, lead, volatile 
organic compounds, oxides of nitrogen, carbon dioxide, methane and 49 toxic air pollutants. The 
Emission Statements provides an estimate of the actual emissions to assist in the monitoring of the 
State’s progress toward the mandatory emissions reduction protocols and attainment of the ozone 
and carbon monoxide National Ambient Air Quality Standards.  
 
Data from the Emission Statement program is used as the basis of the emissions inventory for New 
Jersey’s State Implementation Plan. Several newer environmental protection initiatives highlighted 
the need for a comprehensive and accurate inventory of air contaminants. The strategic protocol of 
the New Jersey Department of Environmental Protection and the National Environmental 
Performance Partnership were created to shift the indicators of environmental performance to 
environmentally based indices.   
 
The data obtained from the Emission Statement program will be made publicly available and 
submitted to the EPA national databases, the National Emissions Inventory and the National Air 
Toxics Assessment. These databases are used by federal and regional planning agencies in the 
development of environmental policy. Data from the emissions statements is also used for the 
calculation of annual New Jersey Title V emissions fees as well as for permitting and compliance 
purposes. 

 
Timeline 
 
Request for Non-Applicability          February 1 of submittal year  
 
Request for Extensions                           May 1 of submittal year 
 
Due Date (electronic submissions)                 May 15 of submittal year 
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Emission Statement Applicability  
 
The Department requires an Emission Statement from any facility whose actual emissions or facility 
wide Potential to Emit meet or exceed any of the following thresholds (refer to N.J.A.C. 7:27-21.2): 
 

• 5 tons per year of Pb 
• 10 tons per year of VOC 
• 25 tons per year of NOx 
• 100 tons per year of any of the following – CO, NH3, PM2.5, PM10, SO2, TSP, or CH4 

 
The facility-wide Potential to Emit incorporates the following emissions sources: 
 

• All allowable emissions from permitted sources; 
• The emissions from all non-permitted sources operating at maximum capacity and 

assuming that the source operates for 8,760 hours per year; and 
• All maximum fugitive emissions. 

 
Please also see the definition of Potential to Emit in the Glossary.  
 
Request for Non-Applicability 
 
If a facility filed an Emission Statement during a prior year and now believes it is no longer subject 
to the Emission Statement applicability statutes specified in N.J.A.C. 7:27-21.2, the Responsible 
Official of the facility is required to submit a Claim of Non-Applicability, as prescribed in N.J.A.C. 
7:27-21.10. The facility must send in the Claim by February 1 of the submittal year. This Claim 
cannot be submitted by a consultant. The facility must continue to submit an annual Emission 
Statement until a Claim of Non-Applicability has been received and approved by the Department. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.state.nj.us/dep/aqm/currentrules/Sub21.pdf
http://www.state.nj.us/dep/aqm/currentrules/Sub21.pdf
http://www.state.nj.us/dep/aqm/currentrules/Sub21.pdf
http://www.state.nj.us/dep/aqm/currentrules/Sub21.pdf
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All Emission Statements sent to the Department must be created using the latest version of the 
Department’s Remote AIMS Data Input User System (RADIUS). Visit 
https://dep.nj.gov/boss/radius/ to download the latest version of RADIUS. 
 
Creating an Emission Statement from Permit Files 
 
Facilities can create a new Emission Statement document in RADIUS from the permit files.  
 

1. Import all permit files into RADIUS using the File>Import function. 
2. Use the Tools>Convert Permit Application function to convert a permit file into an 

Emission Statement file.  
3. When prompted for the emission year, refer to the definition of Emission Year in the 

Glossary. 
4. Use the Tools>Merge Applications function to combine data points into one file. 

 
Creating an Emission Statement from a Previous Year’s Emission Statement 
 
To convert an Emission Statement from a previous for use in the current year:  
 

1. Import the previous year’s file into RADIUS using the File>Import function. 
2. Use the Tools>Emission Statement>Save As with Different Year  
3. When prompted for the emission year, refer to the definition of Emission Year in the 

Glossary. 
 
 

 
 
 
Locked Files 
 
Use the File>Lock/Unlock function to unlock a locked “Submit” file in RADIUS.  
 
 
 
 

https://dep.nj.gov/boss/radius/
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Open the Emission Statement using the File>Open function to reveal the Table of Contents. 
 

 
 
There are nine screens listed under Facility Information Forms in the Table of Contents. To activate 
a screen in RADIUS, double-click the mouse on the screen title. The forms labeled “Non-Source 
Fugitive Emissions,” “Insignificant Source Emissions,” “Equipment Inventory,” “Control Device 
Inventory,” “Emission Point Inventory,” “Emission Unit / Batch Process Inventory,” and “Subject 
Item Group Inventory” list the equipment and accompanying operating parameters for which 
emissions will be reported. Emissions data is not entered in these forms. 
 
For a complete list of NAICS codes, visit: https://www.census.gov/naics/ 
 
 

 
Required Sources 
 
The following sources must be included in the Emission Statement: 
 

• Significant/permitted sources (any item that was permitted for any period of time 
during the reporting year); 

• Insignificant sources; and 
• Fugitive emissions at the facility that are not associated with any source operation. 

 
Refer to Appendix B for a list of exempt sources. 
 
If you created your emission statement file from the permits or from a previous year’s file, most of 
the data in the Facility Information Forms should be pre-filled. Emission Statements should mirror 
the structure of the approved air pollution control permits. However, there are a couple of 
instances where the Emission Statement will need to be slightly different from the permit(s): 

https://www.census.gov/naics/
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• You may need to add new or unpermitted sources such as maintenance shops, cafeteria 

ovens, laboratory hoods, site remediation and R&D facilities that have been kept outside of 
the main facilities’ operating permit.  
 

• Control devices that burn fuel, such as a thermal oxidizer or flare, should be reported as a 
piece of equipment and included in a separate operating scenario so that the amount of fuel 
burned by the control device may be reported.  

 
• Similar small emissions sources can be combined for reporting on the Summary (OS0) level. 

See the Small Sources section below. 
 

• VOC stationary storage tank with a floating roof needs a separate operating scenario to 
report roof landing emissions. If a separate operating scenario is not established in the 
permit, one must be created in the Emission Statement. 
 

Permitted items which did not operate or have been decommissioned but still retain an active 
permit should be included in the Emission Statement.  
 
For a complete list of SCC codes, visit: https://sor-scc-api.epa.gov/sccwebservices/sccsearch/ 
 
Small Sources 
 
Insignificant pieces of equipment (such as laboratory hoods, combustion sources of the same fuel 
type and less than one million BTU’s per hour, storage tanks of less than 2,000-gallon capacity 
containing VOC's and storage tanks containing only non-applicable VOC's) may be combined and 
reported as insignificant sources. This negates the need to report each source individually. Small 
combustion sources can be grouped together by the type of fuel burned but cannot be combined 
with other types of equipment, (e.g., two small generators burning the same fuel can be grouped 
with each other but not with a storage tank). AP-42, Table 1.4-1 of AP-42 has different NOx and CO 
emissions factors for boilers < 0.3 MMBtu/hr than for larger boilers. Therefore, natural gas fired 
boilers less than < 0.3 MMBtu/hr should be separated from larger.  
 
Differentiating Fugitive Emissions and Insignificant Sources 
 
Fugitive emissions are emissions of an air contaminant released directly or indirectly into the 
atmosphere that do not pass through a stack, flue, vent, or chimney. If a source's Potential to Emit 
for criterial air pollutants CO, NOx, NH3, PM2.5, PM10, SO2, TSP and VOC is less than 0.05 lbs/hr, 
and 2 lbs/yr for Pb, the emissions from a piece of equipment may be listed as fugitive emissions.   
 
An insignificant source is any piece of equipment that is not a significant source (see the Glossary 
for the definition of significant source). An insignificant piece of equipment can have source 
fugitive emissions associated to it. Examples of insignificant sources include boilers less than 1 
MMBTU/hr max heat input, VOC storage tanks less than 2000 gallons, and non-applicable VOC 
storage tanks. 
 
 

https://sor-scc-api.epa.gov/sccwebservices/sccsearch/
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Unusual Emissions Upsets and Accidents 
 
The Emission Statement should include emissions from accidents and upsets. Report these 
emissions under the permitted “malfunction” operating scenario following the prescriptions of the 
permit. If the approved air pollution permit does not have an operating scenario nominated for 
malfunction, then the unusual emissions releases may be reported under the “normal” operating 
scenario of that particular emissions unit as fugitive emissions.  
 
Operational Buttons 
 
BATCH PRINT DOCUMENT – Prints the Entire Emission Statement file. 
 
BATCH PRINT DETAILS – Prints information for the document. The Department advises against 
using this function because it prints superfluous information.  To print just the useful information, 
use the printer icon on the tool bar of the section you want to print. 
 
CALCULATE TOTALS – Adds up the emissions for all sources listed for each air pollutant.  This 
function is available in Non-Source Fugitive Emissions and Insignificant Source Emissions screens. 
(Note: No emissions information is required to be entered here for Emission Statement purposes.) 
 
CALCULATE EQUIVALENT DIAMETER – Calculates the equivalent diameter for a given dimension 
of a stack, even non-circular stacks.  This function is in Emissions Point Inventory. 
 
CLEAR CONTACT – Deletes the information in the Contact Information screen being viewed. 
 
COPY – Copies the current field(s) to the next field(s).  
 
COPY CURRENT ROW – Copies the current row to the next row.  
 
COPY TO – Copies the current field(s) to a chosen field(s).  
 
DELETE GROUP – Deletes a group from the Subject Item Group Inventory. 
 
EDIT DESIGNATION – Activates the dialog box for editing the Facility Designation in the Subject 
Item Group Inventory. 
 
EDIT DETAILS – Activates the dialog box for data entry of equipment specific information.  The 
dialog box will request different data for different equipment types.  
 
NEW GROUP – Creates a new group for combining sources in the Subject Item Group Inventory.  
 
RENUMBER NJID – Allows the NJID number to be changed. Does not apply to operating scenario 
numbers.
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Emissions are reported in the Emission Reporting Form. 
 

 
 

Select an option in the General tab if appropriate. Option “NJDEP Default Emission Calculations” 
should be selected if you intend to use the RADIUS Autocalculate feature (discussed in the 
Calculation Methodology section). The sum of the values of the quarterly throughputs Q1 + Q2 + 
Q3 + Q4 must equal 100% before saving.  
 
Confidential Data 
 
Facilities may mark certain process data as confidential (see N.J.A.C. 7:27-1.6 through N.J.A.C. 7:27-
1.30). Emissions data and fuel usage cannot be marked as confidential. If a facility wishes to claim 
process data as confidential, they must provide two copies of the completed Emission Statement to 
the Department: one electronic copy with the “Source Process Data is Considered Confidential” 
option marked and one hard (paper) copy containing the confidential data inscribed with the word 
"Confidential" in bold letters on the top of each page and envelope. Do not submit a disk containing 
confidential information. The Department will make any data submitted on a disk or via the NJDEP 
Online Portal available to the public regardless of any claim of confidentiality.   
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RADIUS has data validation in the ‘Operating Time/Hours’ column for the ‘Entire Year of <year>’ 
row.  This field is located in the Emission Statement screen, Process tab.  Specifically, only integer 
values from 0 to 8760 will be allowed in this field: 
 

• Process data should represent the actual time a source operated 
 

• Continuous operation is represented as 8760 hours / 365 days / 52 weeks, not 24 hours 
/ 7 days / 52 weeks. Count one day if the equipment ran any time during a given 
day.  Count one week if the equipment ran any time during a given week. Unless the 
operation is continuous, Weeks is not usually Days divided by seven. 
 

• Use 8760 hours/year even for leap years. 
 

• Tank operating scenarios normally report all the hours during which breathing losses occur 
unless separate operating scenarios exist for working and breathing losses. For tanks in 
constant use, please list the operating time as “8760 hours / 365 days / 52 weeks”, not “24 
hours / 7 days / 52 weeks.” 
 

• If the process operates less than 1 hour, 1 day or 1 week, round up to the nearest whole 
number. 
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POLLUTANT REQUIREMENTS 
 

 

 
 
Reportable Pollutants 
 
The Emissions section will be pre-populated with pollutants specific to the source type and 
facility type (major or minor). However, it may be necessary to add some pollutants. Refer to the 
table below to determine which pollutants are required. Please note: your permit may not specify 
which pollutants need to be reported. See N.J.A.C 7:27-21.3 for more details. 
 

Facility-Wide Potential to Emit or Actual Emissions Need to Report 

    VOC and NOx < 25 tons                                                  AND 
    CO, SO2, NH3, PM2.5, PM10, TSP and CH4 < 100 tons       AND  
    Pb < 5 tons                                             

VOC, NOx, CO, 
TAPs 

   VOC or NOx ≥ 25 tons                                                      OR 
   CO, SO2, NH3, PM2.5, PM10, TSP or CH4 ≥ 100 tons           OR 
   Pb ≥ 5 tons                                           

VOC, NOx, CO, SO2, 
TSP, PM2.5, PM10, 

NH3, Pb, CH4, CO2, 
TAPs 

 
Appendix H provides a list of reportable Toxic Air Pollutants (TAPs) and the respective reporting 
thresholds. A TAP should be reported for all emissions sources when the facility (as a whole) has a  
Potential to Emit that is equal to or greater than the respective threshold in Appendix H. Some TAPs 
may be required to be included in an Emission Statement even if not listed in an APC Permit.  Please 
see N.J.A.C 7:27-21.3(b) for the complete details. 
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Exempt Compounds 
 
Compounds with negligible photochemical reactivity, exempt from the definition of VOC in 40 CFR 
51.100(s), should not be reported in the Emission Statement as VOC. Some of these compounds may 
need to be reported as PM2.5, PM10, or TSP. For the purposes of Emission Statement reporting only, 
the definition of VOC can be simplified to include those organic compounds (not exempted as VOC’s 
in 40CFR 51.100(s)) that are a liquid or a gas at standard temperature and pressure, or solids that 
sublimate to a gas at standard temperature and pressure. Do not confuse these compounds with 
"non-applicable VOC’s.” Non-applicable VOC’s are certain low vapor pressure organic liquid 
compounds that may need to be incorporated into the VOC emissions estimate. Please see the 
Glossary for the definition of non-applicable VOC.   
 
Particulate Reporting 
 
PM10 and PM2.5 must include the sum of filterables and condensables. Often, emissions factors 
standards separate filterables and condensables. TSP should include only filterable emissions, to 
agree with most current stack test protocols. For material dust, TSP is generally greater than PM10, 
which is generally greater than PM2.5.  Please see AP-42 for estimates. PM10 includes particulates 
less than 2.5 microns; therefore PM10 emissions should never be less than PM2.5 emissions. 
 
Differentiating Air Contaminants 
 
When using emissions factors or other methods of calculating and estimating emissions, separating 
the portion of one air contaminant that belongs to a subset of another air contaminant may not be 
practical. For example, AP-42 contains emissions factors for VOC and TSP.  A portion of the TSP 
emitted may also be a VOC.  The quantity of TSP that is also a VOC would be difficult to figure out 
from the emissions factor or from the documentation in AP-42.  For simplicity reasons, one does 
not need to differentiate (and subtract) one air contaminant from another. Report each air 
contaminant by its category (i.e., VOC, CO, NOx, NH3, TSP, PM10, PM2.5, SO2, or Pb) and do not subtract 
one air contaminant from another air contaminant (e.g., TSP minus PM10, TSP minus VOC). If a TAP 
is a VOC, do not subtract the amount of that TAP from the VOC total. In particular, formaldehyde is 
frequently measured and itemized separately from VOC (often in stack tests). VOC emissions should 
be adjusted to incorporate formaldehyde levels. 
 
Source Level Reporting 
 
Refer to the table below to distinguish between pollutants which must be reported at both the 
operating scenario level (OS) and facility level (FC) and pollutants which may be reported at the 
facility level only. 
 

Report at Facility Level and Source Level CO, NOx, VOC, SO2, TSP, PM2.5, PM10, NH3, Pb, CH4 

Can be Reported at Facility Level Only CO2, TAPs 

 
 
Seasonal Reporting and Reporting Units 
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CO, NOx and VOC require seasonal reporting. Calculate the lb/day for the ozone season as per EPA 
guidance (total seasonal emissions divided by total amount of operating days). RADIUS 
automatically calculates a value for the NOx (Total) tons/season fields for batch processes. This 
value is calculated by multiplying the currently calculated NOx annual total by 5/12, (for the five 
months May through September). Refer to the table below to determine the appropriate units and 
seasonal reporting requirements for each pollutant. For Pb, SO2, TSP, PM10, PM2.5, NH3, CO2, CH4, and 
TAPs, only the annual emissions (tons/year) should be reported.   

 

Pollutant 
Annual 

(1/1-12/31) 
Unit 

Ozone Season 
(5/1-9/30) 

Unit 

Peak Ozone 
Season 

 (6/1-8/31) 
Unit 

Carbon 
Monoxide 

Season (12/1-
2/28) 
Unit 

CO Tons/Year  Pounds/Day Pounds/Day 

NOx Tons/Year Tons/Season Pounds/Day  

VOC Tons/Year  Pounds/Day  
SO2, TSP, PM2.5, 

PM10, NH3, Pb*, CH4 Tons/Year    

CO2 1000 Tons/Year    

TAPs Pounds/Year    
*Please Note: Pb emissions must be reported in tons not pounds.  
 
Operational Buttons 

 

 
 
CONTROL OPERATIONS – Activates the dialog box for reporting control device efficiency (see 
section on Control Device Efficiencies). If the source has more than one control device, the total 
combined efficiencies are reported.   
   
SOURCE DETAILS – Activates the dialog box for data entry of equipment specific information.  This 
information is required for combustion sources, VOC storage vessels, and surface coating/graphic 
arts processes. The dialog box will request different data for different equipment types.  
 
AUTOCALCULATE EMISSIONS – Activates the Autocalcuate feature (discussed more thoroughly in 
the Calculation Methodology section). 
 
SUM FACILITY EMISSIONS – Sums up all the emissions by air contaminant for the entire Emission 
Statement of the facility in the FC page. It should be activated immediately before submittal to 
ensure proper summation in the FC page. 
CALCULATION METHODOLOGY 
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Ranking of Methodologies 
 
Emission statements should report an accurate estimate of actual emissions and not a summary of 
the permitted limits or an exaggeration. Follow the instructions provided in N.J.A.C. 7:27-21.6 when 
choosing a calculation methodology.  The Department is not mandating the institution of a higher-
ranked methodology for the Emission Statement; facilities are only required to use the higher-
ranked methodology when it is reasonably available. However, N.J.A.C. 7:27-21.6 lists several 
instances where a lower-ranked methodology can or must be used. The table below relates the 
N.J.A.C. 7:27-21.6 ranking system to the Calculation Methodology Codes available in RADIUS. 
 

N.J.A.C 
Rank RADIUS Calculation Methodology Code 

1 Continuous Emissions Monitoring 
2 Predictive Emissions Monitoring 
3 Agency approved and supervised source testing 
4 Agency approved and supervised source testing (previous year) 
5 Material balance using engineering knowledge of the process 
6 . AP-42 

· EPA computer program based on other approved emission factor 
· State or local agency's emission factor 
· Emissions to be computer calculated by NJDEP or EPA based on standard 
emission factor (SCC emission factor file) 

7 Manufacturer's Estimate or Data 
8 . Best engineering judgement 

· Industry council or organization emission factor 
· Estimated at one ton per year (0.1 ton per year for Pb) for any unpermitted source 

 
 
Use “EPA computer program based on other approved emissions factor” (Rank 6) for programs 
such as the following: 
 

WATER9 – this program estimates emissions from the equalization and aeration 
basins at wastewater treatment systems 

https://www3.epa.gov/ttnchie1/software/water/water9_3/index.html 
 
LandGEM – this programs provides a landfill gas emissions model 
https://www3.epa.gov/ttn/catc/dir1/landgem-v302-guide.pdf 

 
WebFIRE – this program contains an internal repository of all available emissions 

factors and a distribution system containing any available emissions factors 
https://cfpub.epa.gov/webfire/ 

 
 

http://www.state.nj.us/dep/aqm/currentrules/Sub21.pdf
http://www.state.nj.us/dep/aqm/currentrules/Sub21.pdf
http://www.state.nj.us/dep/aqm/currentrules/Sub21.pdf
https://www3.epa.gov/ttnchie1/software/water/water9_3/index.html
https://www3.epa.gov/ttn/catc/dir1/landgem-v302-guide.pdf
https://cfpub.epa.gov/webfire/
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EIIP – the Air Emissions Inventory Improvement Program 
https://www.epa.gov/air-emissions-inventories/air-emissions-inventory-
improvement-program-eiip 

 
Use “Best Engineering Judgement” (Rank 8) for: 

• NOx RACT tune-up data 
• Department supervised and approved stack tests belonging to a different unit 
• Use of permitted limits as emissions factors for sources that do not meet the simplified 

reporting specifications of N.J.A.C. 7:27-21.5(g) 
 
Use “Industry council or organization emission factor” (Rank 8) for extra-agency resources such as 
the periodical and journals found in Appendix A.2. 
 
Use “Potential emissions are less than one ton per year (0.1 ton per year for Pb) and use the 
emission rate from the current and approved air pollution permit and certificate to operate” when 
utilizing the simplified reporting option discussed in N.J.A.C. 7:27-21.5(g). 
 
RADIUS Autocalculate Feature 
 
Facilities may use the Autocalculate function in RADIUS to calculate emissions from boilers. This 
is available for both insignificant and significant sources. Because of the high variation in fuel 
types, RADIUS Autocalculate can only be used for specific fuel types and firing methods. The 
calculation routines used in RADIUS are based on AP-42. RADIUS can also calculate emissions 
from surface coating and printing equipment, as long as the VOC content of coating is provided. 
 
When using the Autocalculate function for boilers, RADIUS does not calculate the NOx emissions for 
the 5/1-9/30 time period (tons/season), except for Batch Processes. You will have to calculate these 
emissions manually. 
 
To use the Autocalculate feature, select the “NJDEP Default Emission Calculations” option in the 
General tab. Complete the Process information and the Source Details screen for the operating 
scenario. Then press the Autocalculate Emissions button at the bottom of the screen.  
 
Stack Testing 

 
If a facility has stack testing results showing emissions from a source, the facility should apportion 
those emissions into the reported emissions values using actual process rates. For example, if stack 
testing was performed under a certain load then those results should be used for the period of the 
year that the source operated under that load. If available, another emissions factor or stack test 
result should be used for the period of time the source operated under the alternative operating 
loads. Conversely, a facility may use the stack test results without modification if it believes, using 
good engineering judgement, that those results are an accurate representation of the emissions 
during all operations. 
 
In some cases, the emissions from a facility or group of sources may have been determined at the 
stack level rather than at the equipment level. It may be difficult to determine the exact quantity of 
air contaminants that were emitted from each individual piece of equipment. In these cases, total 

https://www.epa.gov/air-emissions-inventories/air-emissions-inventory-improvement-program-eiip
https://www.epa.gov/air-emissions-inventories/air-emissions-inventory-improvement-program-eiip
http://www.state.nj.us/dep/aqm/currentrules/Sub21.pdf
http://www.state.nj.us/dep/aqm/currentrules/Sub21.pdf
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emissions from a stack may be split between equipment based upon the size of the units, how the 
units actually operated, or a combination of the two. For facilities that have accurate fuel monitoring 
methods for each unit, emissions may be apportioned by the BTU content of the fuel used in the unit 
and the total amount of BTU’s generated by the unit. In more complex situations, other additional 
factors such as permitted emissions rates and VOC content of the coating could be used. 
 
The most important thing to remember when apportioning emissions between units is to not 
double count emissions. If two operating sources lead to one stack with a CEM, never report the 
total emissions as recorded by the CEM as the total emissions for each individual source. When the 
emissions from all operating scenarios are totaled, it should accurately reflect the facility-wide total 
emissions. 
 
Formaldehyde is sometimes measured and itemized separately from VOC in stack tests. VOC 
emissions should be adjusted to incorporate formaldehyde levels. 
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CONTROL DEVICE EFFICIENCIES 
 
Activate the Control Operations screen by selecting the Control Operations button in the lower left-
hand corner of the screen. 
 

 
 
The State is required to adjust reported emissions estimates to account for variability in the 
operation and use of control devices. This adjustment, called Rule Effectiveness by EPA, assumes 
that control devices do not always operate at 100% of their efficiency. Accurate data on control 
device efficiency is essential to applying the correct adjustment factor to New Jersey’s inventory of 
air contaminants.  
 
Overall control efficiency is calculated as: 
 
        Overall Control          Operating          Capture          Removal 

Efficiency (%)  = Time (%) x Efficiency (%)      x Efficiency (%) 
           
Operating Time 
 
Operating time is the ratio of time the control device operated compared to the emission source. 
For example, if a device operated half the time while emissions were being generated, then the 
operating time is 50%. 
 
Capture Efficiency 
 
The capture efficiency is the percentage of air stream that is processed by the control device. For 
example, if a control device captures half the emissions stream because the stream's other half is 
diverted elsewhere then the capture efficiency is 50%. 
 
Series: Control devices are considered in series when one control device is directly downstream of 
another device. For example, two control devices are directly connected and the first one, A, has a 
capture efficiency of 100%, this means that it processes all the emissions from the source. If the 
second device, B, also has a capture efficiency of 100%, then the control device B processes all the 
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air contaminants not removed by the control device A. 
 

 
 

Parallel: Control devices are considered parallel when part of the emissions stream is diverted to 
two or more control devices simultaneously. For example, if a source with two parallel control 
devices has 75% of the exhaust directed to control device A, then 25% are directed to control device 
B. The capture efficiencies are 75% for control device A and 25% for control device B. 

 
Removal Efficiency 
 
The removal efficiency of a device considers the elimination of the air contaminant from the 
emissions stream that the device processes. When calculating the removal efficiency of a device, one 
must consider the age and loss of effectiveness of the device.  For example, if a control device is 90% 
effective but, in a linear fashion, reaches 40% effectiveness, and operates continuously, the 
reportable removal efficiency is 65%.  
 
Design Efficiency 
 
Please note that a check box has been added to each form to indicate if the design efficiency of the 
air pollution control device is being reported. Please enter “Yes” in this box if, 1) the operating time 
of the control device was assumed to be 100% of the time, 2) the capture efficiency of the device 
was assumed to be 100%, and 3) the manufacturer’s design efficiency is being reported. If you are 
reporting emissions based upon a continuous emissions monitoring, please do not check this box. 
Facilities should make every effort to report the actual operating efficiency rather than the design 
efficiency. This would avoid the conservative Rule Effectiveness application triggered when the 
design efficiency is used. 
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SOURCE DETAILS 
 
Activate the Source Details screen by selecting the Source Details button in the lower left-hand 
corner of the screen. 
 

 
 
 
Source Details are required for combustion sources. Fuel suppliers have generally decreased the 
amount of sulfur in diesel, #2 fuel oil and other fuel oils. Use the sulfur content from the vendor’s 
SDS, rather than the limits in your permit. Report VOC content of coating/ink/solution for 
coating/printing operations. If a variety of solutions are used, report the weighted average of the 
VOC content, not the largest value. 
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RADIUS Administrative Check 
 
RADIUS has a built-in "completeness" check function which can be accessed by selecting the “check-
mark” icon on the menu bar. 
 
 

 
 
There are three designations for incomplete data: Error, Warning and Note. “Error” indicates that 
an important data element is missing and must be corrected before submission. “Warning” and 
“Note” indicate missing or incorrect data that should be reviewed but do not inhibit submission. 
 
Creating an Emission Statement Submittal File 
 
Use the File>Submit function to create a “Submit” file. This is the only file type accepted for 
Emission Statement submittals. The “Submit” function does not automatically send the 
electronic file to the Department. See the Certification and Submission section for more details. 
 
Accessing a Submittal File 
 
To import a “Submit” file into RADIUS: 

1. Change the file extension to .zip 
2. Open the .zip file and browse through folders RADIUS>Export>  
3. Extract the file out of the .zip folder and import into RADIUS 

 
Locked Files 
 
Use the File>Lock/Unlock function to unlock a locked “Submit” file in RADIUS for further editing.  
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Emission Statements may be submitted through postal mail or online. 
 
Postal Submission 
 
Include a completed hard copy of the certification form found in Appendix E along with a CD-ROM 
or other department approved electronic media containing the RADIUS “submit” file. For security 
reasons, USB flash drives are not accepted. A minimum of 2 certifications are required (1 Individual 
with Direct Knowledge and 1 Responsible Official), however, all persons who completed or assisted 
in completing the Emission Statement forms should certify. Emission Statements submitted 
through the mail without a signed Certification Form will be considered incomplete. Supporting 
calculations (optional) can be included as a hard copy or on a disk. 
 
Online Submission 
 
Submit the RADIUS “submit” file online using the NJDEP Online Portal: https://dep.nj.gov/online/. 
Emission Statements submitted through the NJDEP Online Service Portal must be certified online. 
A minimum of 2 certifications are required (1 Individual with Direct Knowledge and 1 Responsible 
Official), however, all persons who completed or assisted in completing the Emission Statement 
forms should certify. Online submittals that do not reach the “Submission Confirmation” screen will 
be considered incomplete. Supporting calculations (optional) can be attached in the NJDEP Online 
Portal. Emission Statements cannot be submitted via e-mail. The portal can accommodate a 
maximum RADIUS file size of 5 mb; RADIUS files larger than 5 mb must be submitted via postal 
mail.  
 
Any major facility wanting to submit an Emission Statement through the NJDEP Online Portal must 
first have the Individual/s with Direct Knowledge and Responsible Official/s complete and mail/fax 
in a RADIUS Certification Authorization Form (RCAF): 
https://dep.nj.gov/wp-content/uploads/boss/applications-and-forms/rcaf.pdf  
The RCAF is not required for minor facilities. 
 
A step-by-step guide to submitting an Emission Statement using the NJDEP Online Portal can be 
found here:  
https://dep.nj.gov/wp-content/uploads/boss/applications-and-forms/user-guide-for-
online-radius-submittals.pdf 
 
Roof Landing Loss Report 
 
Facilities with VOC stationary storage tank with a floating roof are required to submit a Floating 
Roof Landing Emission Summary Report with the Emission Statement. See N.J.A.C. 7:27-21.5(j) for 
more details. 
 
 
 
 
 

https://dep.nj.gov/online/
https://dep.nj.gov/wp-content/uploads/boss/applications-and-forms/rcaf.pdf
https://dep.nj.gov/wp-content/uploads/boss/applications-and-forms/user-guide-for-online-radius-submittals.pdf
https://dep.nj.gov/wp-content/uploads/boss/applications-and-forms/user-guide-for-online-radius-submittals.pdf
http://www.state.nj.us/dep/aqm/currentrules/Sub21.pdf
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It is the facility's obligation to contact the Department electronically or in writing to obtain 
reporting software, guidance or any materials necessary for Emission Statement reporting and to 
determine applicability. The Department does not accept any responsibility for any facility’s failure 
to provide a complete and certified Emission Statement by the reporting date. The Department is 
under no obligation to provide reporting materials, calculations or notifications. These are provided 
strictly as a courtesy. 
 
Acceptance or receipt of an Emission Statement by the Department does not constitute the 
Department’s acceptance of the truth, accuracy, or completeness of the Emission Statement.  The 
Department’s failure to act on the information contained in an Emission Statement at the time of 
receipt does not bar the Department from any future action based on that information (N.J.A.C. 7:27-
21.3(g)). Any emissions estimates made by the Department (or made by using the computer tools 
provided by the Department) are based solely upon information supplied by the facility; accuracy 
of the estimates remains the sole responsibility of the facility.  
 
Once the Department has determined an Emission Statement to be administratively complete, the 
Department may review the contents to ensure that accurate data has been provided. A facility may 
be asked to confirm that the contents or information provided were according to Department 
regulations, or to provide supporting information. An on-site inspection may occur or a letter may 
be sent, to ascertain compliance with the reporting and certification requirements of the Emission 
Statement regulations. Facilities are reminded that a copy of the Emission Statement and any record 
of justification for the estimates provided by the Emission Statement must be retained for a period 
of five years from the submission due date of the Emission Statement (see N.J.A.C. 7:27-21.7 for 
exact record-keeping requirements). 
 
Emission statement submission is required in N.J.S.A. 13:1B-3, 13:1D-9, and 26:2C-1 et seq., in 
particular N.J.S.A. 26:2C-9 and 19. If a facility fails to comply, it may be subject to enforcement 
actions according to N.J.S.A. 26:2C-19, N.J.A.C. 7:27-21, and N.J.A.C. 7:27A-3.1 et seq.  
 
Data submitted to the Department via disk or upload through the NJDEP Online Portal is not kept 
confidential. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.state.nj.us/dep/aqm/currentrules/Sub21.pdf
http://www.state.nj.us/dep/aqm/currentrules/Sub21.pdf
http://www.state.nj.us/dep/aqm/currentrules/Sub21.pdf
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 The following words and terms, when used in this document, have the following meanings, 
unless the use of the word in its context clearly suggests otherwise. 
 
“AP-42” means the EPA document "Compilation of Air Pollutant Emissions Factors". It is available 

from the EPA website at https://www.epa.gov/air-emissions-factors-and-
quantification/ap-42-compilation-air-emission-factors 

 
“Batch process” means the method of permitting that describes manufacturing operations 

(normally related to the chemical or pharmaceutical industries) that involves multiple 
components and multiple manufacturing operations. Continuity of the flow of raw materials 
into and the flow of products from production equipment primarily differentiates an 
emissions unit process from a batch process. Batch processes occur when raw material 
input and product removal does not occur simultaneously. 

 
“Batch run time” means the total elapsed time per batch from the start of adding raw materials to 

the completion of the reaction or process. This excludes time waiting for removal of batch 
product from a vessel. This exclusion is consistent with "batch cycle time" in N.J.A.C. 7:27-
16. Because the Department will allow the grouping of similar batches, the batch run time is 
reported as an average time of the batches that may have been grouped together. 

 
"Capture efficiency" means the amount of an air contaminant collected by a control apparatus 

serving the source operation, expressed as a percentage of the total amount of the air 
contaminant emitted by the source operation. 

 
"Carbon monoxide season" means December 1 through the last day of February, inclusive. Please 

note that the last day of February differs in a leap year. 
 
“CAS number” means the Chemical Abstract Service number of a chemical compound or mixture. 

The CAS number can be acquired from the facility's Safety Data Sheets (SDS). The CAS 
number is important information because of the several systems of organic compound 
nomenclature that have survived over the years. The chemical abstract numbers are 
surrogate means by which the Department assures the proper identity of reported 
information, particularly in light of some use of "common" names or trade names in addition 
to the various systems. 

 
"Control efficiency" means the amount of air contaminant prevented from being discharged into 

the outdoor atmosphere by a control apparatus, expressed as a percentage of the total 
amount of the air contaminant collected by the control apparatus. 

 
“DEP” or “the Department” means the New Jersey Department of Environmental Protection. 
 
“Emissions unit” means the permitting method that describes one or more significant component 

operations.  Stand-alone equipment can make up an emissions unit. Making collective data 
presentation easier to understand, pieces of equipment with physical commonalities such 
as common exhaust systems may constitute an emissions unit. An emissions unit process is 

https://www.epa.gov/air-emissions-factors-and-quantification/ap-42-compilation-air-emission-factors
https://www.epa.gov/air-emissions-factors-and-quantification/ap-42-compilation-air-emission-factors
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more likely to be a continuous operation, where raw materials enter production equipment 
as product is removed from it. Each piece of equipment may only appear in one emissions 
unit. 

 
“Emission Year” means the reporting year. It is the year in which emissions actually occurred. 
 
“EPA” means the United States Environmental Protection Agency. 
 
"Equipment" means any device capable of causing the emissions of an air contaminant either 

directly or indirectly to the outdoor atmosphere, and any stack or chimney, conduit, flue, 
duct, vent, or similar device connected or attached to, or serving the equipment. This term 
includes, but is not limited to, a device in which the preponderance of the air contaminants 
emitted is caused by a manufacturing process. 

 
"Facility" means the combination of all structures, buildings, equipment, control apparatus, storage 

tanks, source operations, and other operations located on a single site or on contiguous or 
adjacent sites and that are under common control of the same person or persons.  

 
"Federally enforceable" means any limitation or condition on operation, production, or emissions 

that can be enforced by the EPA pursuant to authorities that include, but are not limited to, 
those established in rule, regulation, or permit. 

 
“Firing Method” means the manner on how equipment introduces fuel into the area where it is 

burned and is an indication of the type of equipment (e.g., diesel engine, pulverized coal - 
wet bottom, an asphalt plant burner or conventional wall fired equipment). It is not about 
how the fuel is ignited e.g., electrodes for fuel oil, pilot light for gas.  

 
"Fugitive emissions" means any air contaminant emissions released directly or indirectly into the 

outdoor atmosphere which cannot reasonably pass through a stack or chimney.  
 
“Graphic arts operation” means the application of one or more surface coating formulations 

across portions of a surface using one or more rotogravure or flexographic printers used to 
produce published material and packaging for commercial or industrial purposes, or any 
rotogravure or flexographic printers used to produce vinyl or urethane coated fabric or 
sheets, or any sheet fed gravure, screen printing, or fabric printing operations together with 
any associated drying or curing areas. A single graphic arts operation ends after drying or 
curing and before other surface coating formulations are applied. For any web line, this term 
means an entire application system, including any associated drying ovens, or areas 
between the supply roll and take-up roll or folder. 

 
“Grandfathered” means, in reference to equipment or control apparatus, that construction, 

reconstruction, or modification occurred prior to the enactment of N.J.S.A. 26:2C-9.2 on June 
15, 1967, or prior to the subsequent applicable revisions to rules and regulations codified 
at N.J.A.C. 7:27-8 that occurred March 5, 1973, June 1, 1976, April 5, 1985, and October 31, 
1994, and no construction, reconstruction, or modification of the equipment or control 
apparatus has occurred since. Grandfathered equipment must be reported in an Emission 
Statement. 
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"Incinerator" means any device, apparatus, equipment, or structure using combustion or pyrolysis 
for destroying, reducing, or salvaging any material or substance, but does not include 
thermal or catalytic oxidizers used as control apparatus on manufacturing equipment. 

 
“Insignificant Source” means any piece of equipment that is below the thresholds for a significant 

source. 
 
"Manufacturing process" means any action, operation or treatment embracing chemical, 

industrial, manufacturing or processing factors, methods or forms including, but not limited 
to, furnaces, kettles, ovens, converters, cupolas, kilns, crucibles, stills, dryers, roasters, 
crushers, grinders, mixers, reactors, regenerators, separators, filters, reboilers, columns, 
classifiers, screens, quenchers, cookers, digesters, towers, washers, scrubbers, mills, 
condensers, or absorbers. 

 
“SDS” means Safety Data Sheet. 
 
"NAICS" means the North American Industry Classification System Code, assigned by the United 

States Office of Management and Budget, which classifies establishments according to the 
type of economic activity in which they are engaged. 

 
“N.J.A.C.” means New Jersey Administrative Code. 
 
“NJDEP Online Portal” is DEP’s Business Portal allowing for RADIUS submissions, permits and 

other regulated documents to be submitted to the Department, and accessed through 
NJDEP| DEP Online | DEP Online-Business Portal . 

 
"Non-Applicable VOC" means a VOC that has a vapor pressure (or, if a mixture, the sum of its 

partial pressures) of less than 0.02 pounds per square inch absolute (psia).  For the purposes 
of Emission Statement reporting, this term is only applicable to deciding if several VOC 
storage tanks can be reported on one form as a group or if each VOC storage tank needs to 
be reported individually. Non-Applicable VOCs are not necessarily exempt from reporting 
in the emission statement. 

 
“NSPS” means New Source Performance Standards. 
 
“NTIS” means the National Technical Information Services. 
 
“Operating permit” means a permit issued by the Department pursuant to N.J.A.C. 7:27-22 to 

authorize the use of one of more source operations from which air contaminants may be 
emitted. 

 
“Operating scenario” means a plan for operating a facility or a portion thereof in a way, or 

according to a method, or using methods or processes, which are different from other 
methods or processes used at the facility, or portion thereof. An operating scenario may be 
incorporated into a permit through issuance of an initial operating permit, minor 
modification, significant modification, or authorized through a seven-day-notice.  

 
“Order” means any and all orders issued by the New Jersey Department of Environmental 

https://dep.nj.gov/online/
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Protection including, but not limited to, Administrative Orders and Administrative Consent 
Orders. This term is pertinent only to the definition of federally enforceable. 

 
“Overall control device efficiency” means the percentage of the air contaminant removed from 

the entire air stream (i.e., the emissions) from a source by a control apparatus that is 
prevented from being discharged into the outdoor atmosphere. The overall control 
efficiency is the product of the operating time, the capture efficiency, and the removal 
efficiency. For more details, see the section in this Guidance Document titled “Estimating 
The Overall Efficiency of Emissions Control Devices”. 

 
“Ozone Season” means May 1 through September 30, inclusive. Also see “Peak ozone season”. 
 
"Peak ozone season" means June 1 through August 31, inclusive.  
 
"Percent quarterly throughput" means the percentage of the total 12-month operating activity 

that occurs during each of the following periods: 
 
  Q1) January 1 through March 31 
  Q2) April 1 through June 30 
  Q3) July 1 through September 30 
  Q4) October 1 through December 31  
 

Percent quarterly throughput, denoted as Q1, Q2, Q3 and Q4, should be updated to reflect 
the calendar year quarters. This change does not affect the need to report daily estimates of 
CO emissions using data (e.g., fuel use) from the prior calendar year. Daily estimates of CO 
emissions must be based on actual data obtained from December of the prior year and 
January and February of the reporting year.   

 
“Permit” means any permit issued pursuant to the requirements established under the Air 

Pollution Control Act, N.J.S.A. 26:2C-1 et seq., or N.J.A.C. 7:27-1 et seq., except to the extent 
that the permit includes any prohibition established solely pursuant to N.J.A.C. 7:27-8.8(f). 

 
"Potential-to-Emit" means the maximum aggregate capacity of a source operation or of a facility 

to emit an air contaminant under its physical or operational design. Any physical or 
operational limitation on the capacity of a source operation or a facility to emit an air 
contaminant, including control apparatus, and restrictions on hours of operation or on the 
type or amount of material combusted, stored or processed, shall be treated as part of its 
design if the limitation is federally enforceable. Fugitive emissions shall be included in the 
determination of potential-to-emit. However, the determination shall not include any 
banked emissions reductions held by the owner or operator. 

 
"Predictive Emissions Monitoring" means the method to predict the emissions rate using EPA 

Performance Specification 16, Specifications and Test Procedures for Predictive Emission 
Monitoring Systems in Stationary Sources.  Predictive Emission Monitoring Systems (PEMS) 
utilize advanced mathematical models to provide reliable and accurate real-time emission 
estimations using process parameters (e.g. pressure, temperatures, flow, etc.) as input 
variables. 
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"Product" means the output from a source operation, equipment, or control apparatus. Such 
outputs may include mixtures, composites, compounds and elemental substances.  
“Product” may be MMBtu for an institutional boiler or kWh for a generator. 

 
"Raw material" means any input to equipment, control apparatus, or a source operation, including 

fuels, but excluding heat and other forms of energy. Such inputs may include mixtures, 
composites, compounds and elemental substances. 

 
“Reporting Year” means the calendar year during which emissions reported in an Emission 

Statement were emitted, except that carbon monoxide emissions emitted in December of 
the preceding calendar year shall also be reported as part of the peak carbon monoxide 
season emissions in a given year.  

 
"Responsible Official" means one of the following: 
 

(1) For a corporation: a president, secretary, treasurer, or vice-president of the corporation 
in charge of a principal business function, or any other person who performs similar 
policy or decision making functions for the corporation, or a duly authorized 
representative of such person if the representative is responsible for the overall 
operation of one or more manufacturing, production, or operating facilities applying for 
or subject to a permit and either: 

 
(i) the facilities employ more than 250 persons or have gross annual sales or 

expenditures exceeding $25 million (in second quarter 1980 dollars);  
 
(ii) the delegation of authority to such representative is approved in advance by the 

Department 
 

(2) For a partnership or sole proprietorship: a general partner or the proprietor, 
respectively; 

 
(3) For a municipality, state, federal, or other public agency: either a principal executive 

officer or ranking elected official. For the purposes of this part, a principal executive 
officer of a federal agency includes the chief executive having responsibility for the 
overall operations of a principal geographic unity of the agency (e.g., a regional 
administrator of the EPA); or 

 
(4) For affected sources under Title IV of the Clean Air Act: 

 
(i) the designated representative as far as actions, standards, requirements, or 

prohibitions under Title IV of the Clean Air Act or the regulations promulgated 
thereunder are concerned; and 

 
(ii) the designated representative for any other purposes under 40 CFR part 70. 

 
“SCC” means Standard Classification Code as established by the EPA. 
 
"Significant equipment or source operation" means one of the following: 
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(1) In respect to a source operation at a facility which is subject to the operating permit 

requirements of N.J.A.C. 7:27-22, this term has the meaning defined for the same term 
at N.J.A.C. 7:27-22.1; 
 

(2) Otherwise, this term has the meaning defined for the same term at N.J.A.C. 7:27-8.1, 
except that for the purposes the emission statement, no source operation shall be 
excluded from being classified as a significant source operation solely because it is a 
grandfathered source. That is, even though for the purposes of N.J.A.C. 7:27-8, a source 
operation would be excluded from being classified as a significant source operation if it 
meets the following three criteria, it is not so excluded for the purposes of the emission 
statement:  

 
(i) The source operation was in operation prior to the date that source operations 

of its kind were subject to permit requirements under N.J.A.C. 7:27-8; 
 

(ii) The source operation has not been reconstructed or modified since that date 
referenced in 2i above; and 

 
(iii) The source operation is still operable. 

 
“Submittal year” means the calendar year in which an Emission Statement is required to be 

submitted. This term may be contrasted with the term “reporting year,” defined above, 
which is the temporal period during which the emissions that are reported in an Emission 
Statement are emitted. 

 
“Surface coating operation” means the application of one or more surface coating formulations 

across an entire surface, using one or more coating applications, together with any 
associated drying or curing areas. A single surface coating operation ends after drying or 
curing and before other surface coating formulations are applied.  For any web coating line, 
this term means an entire coating application system, including any associated drying ovens, 
or areas between the supply roll and take-up roll, that is used to apply surface coating 
formulations onto a continuous strip or web.  

 
“Title V” means the operating permit required by N.J.A.C. 7:27-22 for major facilities. 
 
“Toxic Air Pollutant” means any of the substances listed in N.J.A.C. 7-27:21, Appendix 1, Table 1 or 

Table 3, (Do not confuse Toxic Air Pollutants with TXS (Toxic Substances) from N.J.A.C. 7:27-
17.) 
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A.1 NTIS 
 
AIRS Facility Subsystem Source Classification Codes and Emission Factor Listing for Criteria 

Pollutants, EPA/450/4-90-003, March 1990. 
 
PM10 Emission Factor Listing Developed by Technology Transfer and AIRS Source Classification 

Codes with Documentation, PB91-148411/HMD, EPA/450/4-89/022, November 1989. 
 
Revised Emissions Estimation Methodologies for Industrial, Residential, and Electric Utility 

Stationary Combustion Sources, Final Report, PB93-135663/HDM, EPA/60/R-92/239, 
December 1992. 

 
Emission Factors for Iron and Steel Sources: Criteria and Toxic Pollutants, Final Report, PB90-

242314, EPA/600-2-90/024, June 1990. 
 
Fugitive Dust Model (FDM) User’s Guide (Revised), Volume 1, User’s Instructions, Final Report, 

PB90-215203/HDM, EPA/910/9-88/202R, May 1990. 
 
Air Emissions Species Manual, Volume 2, Particulate Matter Species Profiles, Second Edition, Final 

Report, PB90-184367/HDM, EPA/450/2-90/001B, January, 1990. 
 
Methodologies for Estimating Air Emissions from Three Non-Traditional Source Categories: Oil 

Spills, Petroleum Vessel Loading and Unloading, and Cooling Towers, PB93-181592/HDM, 
EPA/600/R-93/063, April 1993. 

 
Development of size-Specific Data from Particulate Control Technology Research Reports, Final 

Report, PB93-131456/HDM, EPA/600/R-92/214, November 1992. 
 
Crosstalk/Air Toxic Emission Factor (XATEF) Database Management System User’s Manual, 

Version 1.2, Final Report, PB92-105527/HDM, EPA/450/2-91/028, October 1991. 
 
Volatile Organic Compound (VOC) and Particulate Matter (PM) Speciation (Speciate) Data Systems 

User’s Manual, PB92-105527/HDM, EPA/450/4-91/027, October 1991. 
 
Toxic Air Pollutant Emission Factors – A Compilation for Selected Air Toxic Compounds and 

Sources, Second Edition, Final Report, PB91-126003/HDM, EPA/450/2-90/011, October 
1990. 

 
Air Toxic Emissions from Iron Foundries, PB91-223206/HDM, EPA/600/D-91/150, 1991. 
 
Emission Factors for Iron Foundries, Criteria and Toxic Pollutants, Final Report, PB90-

266743/HDM, EPA/600/2-91/044, August 1990. 
 
Emissions of Metals and Organics from Municipal Wastewater Sludge Incinerators, Volume 1, 

Summary Report, Final Report, PB91-151480/HDM, EPA/600/2-91/007a, September 



 

32 
 

1989. 
 
 
These two references were highlighted in this Guidance Document in previous years. 
 
Estimating Releases and Waste Treatment Efficiencies for the Toxic Chemical Release Inventory 

Form, EPA 560/4-88-002, U.S. Environmental Protection Agency, Office of Pesticides and 
Toxic Substances, December 1987. 

 
Emission Factors for Equipment Leaks of VOC and HAP, EPA-4540/3-86-002, U.S. Environmental 

Protection Agency. 
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Combustion emissions inventoried within the Off-Highway and Equipment programs should not be 
duplicated on the Emission Statement. Examples are listed below. Non-combustion emissions from 
these sources should be reported in the Emission Statement, e.g., particulate emissions from 
crushing/processing equipment or VOC leaks from pump seals or compressors. 

 
Light Commercial Equipment 

Generator Sets <  50 HP Gas Compressors < 50 HP 
Pumps < 50 HP Welders <  50 HP 

Air Compressors <  50 HP Pressure Washers <  50 HP 
 

Industrial Equipment 
Aerial Lifts Other General Industrial Equipment 

Forklifts Other Material Handling Equipment 
Sweeper Scrubbers  

 
Construction Equipment 

Asphalt Pavers Trenchers Rough Terrain Forklifts 
Tampers/Rammers Bore/Drill Rigs Rubber Tire Loaders 

Plate Compactors Excavators Rubber Tire Dozers 
Concrete Pavers Concrete/Industrial Saws Tractors/Loaders/Backhoes 

Rollers Cement and Mortar Mixers Crawler Tractors 
Scrapers Cranes Skid Steer Loaders 

Paving Equipment Graders Off-Highway Tractors 
Surfacing Equipment Off-Highway Trucks Dumpers/ Tenders 

Signal Boards Crushing/Processing 
Equipment 

Other Construction Equipment 

 
Agricultural Equipment 

2-Wheel Tractors Balers 
Agricultural Tractors Tillers 
Agricultural Mowers Swathers 

Combines Hydro Power Units 
Sprayers Other Agricultural Equipment 

 
Chainsaws/Shredders/Fellers 

Chain Saws Shredders 
Fellers/Bunchers Skidders 

 
Unless contained in an approved air pollution permit, the following sources also should not be 
included in a facility's Emission Statement: 
 

• Fuel burning sources for residential heating of duplex or single residence dwellings; 
• Fuel oil tanks for residential heating of duplex or single residence dwellings; 
• Pressurized tanks, e.g., propane or LPG; 
• Delivery vessels, e.g., 55 gallon drums; and 
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A Working Group of the Research & Development Council of New Jersey provides the following 
guidance for reporting fugitive emissions from laboratory hoods, based on a consensus of 
estimating techniques rather than experimental data. Use of the proposed calculation methods 
is limited to Emission Statement requirements (N.J.A.C. 7:27-21) and is not intended for 
establishing regulatory limits.    

 
1. Hood Emissions Factors - Analysis of the emissions data reported from 17 of the largest 

R&D facilities in the State, including an evaluation of organic chemical usage, vapor pressure, 
and nature of operations in the hoods provides the following emissions factors. The database 
used to develop these factors had 60% of the laboratories in the Low VOC Usage Group and 
20% in each of the other groups. Although not unanimous, the Working Group was 
overwhelmingly in favor of prescribing these emissions factors as most reasonable.  Most 
laboratories do not have nor could they quantify the resources for constant data collection 
and analysis required for a more technically sophisticated approach.  

 
Group VOC Usage Emissions 

Factor 
Group I Heavy VOC Usage (Petroleum, Petrochemical, 

Pharmaceutical, etc.) 
30 
lbs/yr/hood 

Group II Medium VOC Usage (Flavors/Fragrances, 
Biotechnology, and Adhesive) 

15 
lbs/yr/hood 

Group III Low VOC Usage (Electronics, Semiconductors, and 
Polymers) 

5 lbs/yr/hood 

 
2. Purchase Volumes Multiplied by Loss Factor - For facilities where operations are 

reasonably constant and predictable, a calculation based on purchased materials times a 
constant loss factor would be acceptable. 

 
3. Mass Balance - Facilities having accurate records of purchased solvents and wastewater 

composition estimate using a difference calculation. 
 
4. Displacement Calculation - Facility management may calculate losses to emissions based 

on accurate purchase records and estimating the volume displacement of transferring 
solvents from one type of container to another, using the Ideal Gas Law and assuming the air 
displaced is saturated with solvents. 

 
5. Stack Measurements -Conduct stack gas analyses of all or a representative number of hoods 

at the facility. Measurements conducted in the stack should include those methods, which the 
facility management believes are technically reasonable... 
 

Facility managers who feel that none of the above estimating methods are suitable for their 
facility have the prerogative to propose methodologies unique to their situation. 

http://www.state.nj.us/dep/aqm/currentrules/Sub21.pdf
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These Emissions Factors Are for Emission Statement Reporting Only 
 
The purpose of this appendix is to provide some general guidance on estimating the emissions of 
lead from fuel combustion sources. These emissions factors should not be used for determining 
compliance with any order, rule, or regulation of the Department or for specific air pollution control 
permitting situations. Note that lead is reported as elemental lead, rather than the total weight of 
lead compounds. These emissions factors should only be used if no superior methodology is 
available. 
 
 
Fuel Type and Source 
 
1. Residual oil (#4, #5 or #6) – For all uncontrolled boilers 

 
0.0042 lbs/Mgals.  This assumes a 150,000 Btu/Gal fuel heating value. 

 
2. Distillate oil (#2), kerosene, and similar fuels – For all uncontrolled internal and external 

combustion engines 
 

0.0013 lbs/Mgals.  This assumes a 141,000 Btu/Gal fuel heating value. 
 
3. Natural gas – For all controlled and uncontrolled internal combustion sources 
 

0.00 lbs/mmscf 
 
4. Bituminous coal – With pulverized coal-fired utility boilers with ESP control 
 

Use equation: 

 
Where: 
 EFPb = emissions factor for lead, pg/J 
 Hc = higher heating value of coal, kJ/kg 
 E = fractional particulate collection efficiency of control device 
 ERPb = enrichment factor for lead 
 (CPb)c = concentration of lead in coal, ppm 

f = fraction of coal ash as fly ash. Use a fly ash fraction of  0.80 for dry bottom, .65 
for wet bottom 

 
Fuel Specific Units: Multiply derived factor (lb/1012 Btu) by the heating value of coal 
(Btu/lb) and by 2, 000 (lb/ton) to calculate factor (lb/ton).  For example, (74 lb Pb/1012 
Btu)(13,077 Btu/lb)(2000 lb/ton) = 0.0019 lb/ton. 
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New Jersey Department of Environmental Protection 
Certification Form for the ______ Emission Statement 

 
Company Name           Facility ID     
 
1. Responsible Official – This first tier of this certification is to be signed by a Responsible Official as defined in 

N.J.A.C. 7:27-1. 
 
“I certify under penalty of law that I have personally examined and am familiar with the information submitted in the 
attached document and, based on my inquiry of those officials immediately responsible for obtaining the information, 
I believe that the submitted information is true, accurate and complete. I certify that, based on my inquiry of those 
officials immediately responsible for obtaining the information, I believe that any estimates are the result of good faith 
application of sound professional judgement, using techniques, factors, or standards approved by the Department or 
EPA, or generally accepted in the trade. I am aware that there are significant civil and criminal penalties, including 
fines or imprisonment or both, for submitting false, inaccurate or incomplete information." 
 
Name (type or print)         Title       
 
 
Signature          Date       
 
 
2. Individuals with direct knowledge – This second tier of certification is to be signed by the individual or 

individuals with direct knowledge and/or responsibility for the information contained in the attached spreadsheet. 
Please use a copy of this form if you need to have this certified by more than two individuals. 

 
“I certify under penalty of law that I believe the information provided in this document is true, accurate, and complete. 
For those portions of the document that are based on estimates, those estimates are the result of good faith application 
of sound professional judgement, using techniques, factors, or standards approved by the Department or EPA, or 
generally accepted in the trade. I am aware that there are significant civil and criminal penalties, including fines or 
imprisonment or both, for submitting false, inaccurate or incomplete information.” 
 
Name (type or print)         Title       
 
 
Signature          Date       
 
 
“I certify under penalty of law that I believe the information provided in this document is true, accurate, and complete. 
For those portions of the document that are based on estimates, those estimates are the result of good faith application 
of sound professional judgement, using techniques, factors, or standards approved by the Department or EPA, or 
generally accepted in the trade. I am aware that there are significant civil and criminal penalties, including fines or 
imprisonment or both, for submitting false, inaccurate or incomplete information.” 
 
 
Name (type or print)         Title       
 
 
Signature          Date       
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1. Import packet creation failed. Couldn’t find header portion. File is not correct format. 

 
 

 
 
This error usually appears when attempting to upload a “Submit” file directly into RADIUS. First, 
change the file extension to .zip. Open up the zip folder and look through the directories 
Radius>Export> and you will find the importable version of the file. Copy and save this file 
outside of the zip folder and import into RADIUS.  
 

 
2. Improper summation  

 

 
 
Emissions from individual operating scenarios may fail to properly sum in the summary 
operating scenario (OS0) and in the facility total (FC) page. When this happens, the dropdown 
menu will display the individual operating scenarios highlighted in blue but the summary in 
black (as shown above). You can correct this by refreshing the emissions data in one of the 
individual operating scenarios (not the OS0). Change one of the emissions values in the emissions 
tab and press the save icon. Change it back to its original value and press the save icon again. If 
done correctly, the summary operating scenario (OS0) should change to blue in the dropdown. 
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3. Seasonal reporting for pollutants other than VOC, NOx and CO 

 

 
 
Seasonal data is required only for CO, NOx and VOC. If the ozone season or carbon monoxide season 
fields are not grayed out, select a different pollutant from the drop down menu and press the save 
icon. Then, use the drop-down menu again to change back to the original pollutant and press the 
save icon. This will gray out the fields so that data does not have to be reported in them. 
 
 
 

4. Error Number 35 - novaPDF 
 

 
 
If you receive this error, your RADIUS installation may have become corrupted. Please download 
and re-install RADIUS. You will need to have administrative privileges for RADIUS to install 
correctly. You can re-install on top of the current installation (without first uninstalling) to ensure 
that your existing files are preserved. 
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5. Fuel Combustion Details – Database Error: nvo_emission_load_permits.uf_prefill_fuel 

 
 

 
 
Emission Fuel Combustion errors will occur during the emission statement administrative 
check in RADIUS. The flagged emission unit operating scenario may then have the database 
error screen pop up when trying to enter the fuel combustion parameters. The RADIUS file 
should be exported and emailed to the NJDEP Emission Statement support email “DEP 
Emis_Statement” (Emis_Statement@dep.nj.gov) with the impacted emission units and 
operating scenarios that were flagged in the administrative check. NJDEP support will enter 
some “dummy” values in the affected operating scenarios, save the RADIUS file and return the 
export file so the correct values may be entered to replace the dummy values. 
 
 
 

6. Pollutant summarization error, amounts cleared in “FC” emissions summary 

 
 

mailto:Emis_Statement@dep.nj.gov
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The two pollutants in this case, TSP and PM-10 (Total), were to be deleted from the emissions 
statement, rather than reported as “0”. However, the pollutants would not clear from the “FC” 
summary screen after performing an administrative check in RADIUS, resulting in the error 
messages to enter emissions for the two pollutants. Each operating scenario, including those 
that did not have reportable emissions for that reporting year or were marked as “Did not 
operate” will still need to be checked to see if they have the respective pollutants listed in 
their list of emissions, and acted upon accordingly (in this case, deleted from those operating 
scenarios). Otherwise the pollutants will keep creating the error messages during the 
administrative check and repopulating in the FC emissions summary screen. 
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Required Pollutants (Refer to N.J.A.C 7:27-21.3(b)) 
 

Facility-Wide Potential to Emit or Actual Emissions Need to Report 

    VOC and NOx < 25 tons                                                  AND 
    CO, SO2, NH3, PM2.5, PM10, TSP and CH4 < 100 tons       AND  
    Pb < 5 tons                                             

VOC, NOx, CO, 
TAPs 

   VOC or NOx ≥ 25 tons                                                       OR 
   CO, SO2, NH3, PM2.5, PM10, TSP or CH4 ≥ 100 tons            OR 
   Pb ≥ 5 tons                                           

VOC, NOx, CO, SO2, 
TSP, PM2.5, PM10, 

NH3, Pb, CH4, CO2, 
TAPs 

 
 
Reporting Units and Seasonal Reporting 

 

Pollutant 
Annual 

(1/1-12/31) 
Unit 

Ozone Season 
(5/1-9/30) 

Unit 

Peak Ozone 
Season  

(6/1-8/31) 
Unit 

Carbon 
Monoxide 

Season (12/1-
2/28) 
Unit 

CO Tons/Year  Pounds/Day Pounds/Day 

NOx Tons/Year Tons/Season Pounds/Day  

VOC Tons/Year  Pounds/Day  
SO2, TSP, PM2.5, 

PM10, NH3, Pb, CH4 Tons/Year    

CO2 1000 Tons/Year    

TAPs Pounds/Year    
 
 

Source Level Reporting Requirements 
  

Report at Facility Level and Source Level CO, NOx, VOC, SO2, TSP, PM2.5, PM10, NH3, Pb, CH4 

Can be Reported at Facility Level Only CO2, TAPs 
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(REPORTING YEAR 2022 & BEYOND) 

CAS Number Air Contaminant Reporting Threshold 
75070 Acetaldehyde 21 lb/yr 

107028 Acrolein 1 lb/yr 
107131 Acrylonitrile 1 lb/yr 

 Arsenic and compounds 0.01 lb/yr 
71432 Benzene* 6 lb/yr OR 0.01 lb/hr 

 Beryllium and compounds 0.02 lb/yr 
106990 1,3-Butadiene 1.5 lb/yr 
50328 Benzo(a)pyrene 0.04 lb/yr 

 Cadmium and compounds 0.01 lb/yr 
56235 Carbon tetrachloride* 8 lb/yr OR 0.01 lb/hr 

7782505 Chlorine 9 lb/yr 
67663 Chloroform* 2 lb/yr OR 0.01 lb/hr 

 Chromium and compounds 1,000 lb/yr 
7440484 Cobalt metal and compounds 0.005 lb/yr 

 Cyanide compounds (as hydrogen 
cyanide) 35 lb/yr 

542756 1,3-Dichloropropene 11.5 lb/yr 
123911 1,4-Dioxane* 9 lb/yr OR 0.01 lb/hr 

 Dioxins 0.00012 lb/yr 
100414 Ethyl benzene 19 lb/yr 
106934 Ethylene dibromide* 0.08 lb/yr OR 0.01 lb/hr 
107062 Ethylene dichloride* 1.8 lb/yr OR 0.01 lb/hr 
151564 Ethyleneimine* 0.002 lb/yr OR 0.01 lb/hr 
75218 Ethylene oxide 0.02 lb/yr 
50000 Formaldehyde 3.5 lb/yr 

 Glycol ethers (as 2-methoxy ethanol) 1000 lb/yr 
118741 Hexachlorobenzene 0.1 lb/yr 
302012 Hydrazine 0.01 lb/yr 

7647010 Hydrochloric acid 900 lb/yr 
7664393 Hydrogen fluoride 600 lb/yr 
7439965 Manganese and compounds 0.6 lb/yr 

 Mercury and compounds 2 lb/yr 
75092 Methylene chloride* 2000 lb/yr OR 0.01 lb/hr 

1634044 Methyl tert-butyl ether 180 lb/yr 
91203 Naphthalene 1.4 lb/yr 

 Nickel and compounds 0.6 lb/yr 
7723140 Phosphorous 3.2 lb/yr 
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1336363 Polychlorinated biphenyls 0.5 lb/yr 
 Polycyclic organic matter 2 lb/yr 

78875 Propylene dichloride 4.5 lb/yr 
91225 Quinoline 0.05 lb/yr 

100425 Styrene 80 lb/yr 
79345 1,1,2,2-Tetrachloroethane* 0.8 lb/yr OR 0.01 lb/hr 

127184 Tetrachloroethylene* 180 lb/yr OR 0.01 lb/hr 
71556 1,1,1-Trichloroethane* 2000 lb/yr OR 0.01 lb/hr 
79005 1,1,2-Trichloroethane* 3 lb/yr OR 0.01 lb/hr 
79016 Trichloroethylene* 8 lb/yr OR 0.01 lb/hr 

121448 Triethylamine 325 lb/yr 
75014 Vinyl chloride 5 lb/yr 

1330207 Xylene 2000 lb/yr 
*Compounds with more than one threshold are reportable if either of the listed thresholds (annual or hourly) is met.  See N.J.A.C. 7:27-21.3(b) 
for more details. 
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